Setting up your meet in Meet Manager

Pre-Meet

1. Save the meet as a new file before you get going. File>Restore—> Unzip, copy database to a selected folder, and open
this database (the 4w option down)

a. Find where the saved template file is and click open
b. Select a place to save it (C:\ swmeets4 is fine)
c. Name the meet. File>Save As> Add the filename (Ex: 2013/06/19 FAC, MS @ SDALE)

d. You'll get a series of questions about Meet Mobile; you’ll want to cancel your way out of those
2. Go to Setup—~>Meet Set-Up
a. Adjust the meet name (recommend you put the date first in Year/Month/Day format, then list the away teams,
then the home team; Ex: 2013/06/19 FAC, MS @ SDALE)
b. Enter the name of your facility
The only portion of the address required is the city & the edited zip code

d. Edit the start date and the entry deadline (the entry deadline was determined to be 2 days before the start
date)

e. Solongas we’re ok with an age-up date as June 1s, there’s no change necessary for the age-up date
f. If your pool is 25 meters, change the course from yards to meters; click OK.

3. Edit your session details; From the main screen: Events=>Sessions
a. There are 3 windows; on the top double click on the 6:00 time.

b. Change the start time to your meet start time (Recommended: Always start your timeline for 10 minutes late
to be ready for timer issues, getting kids ready, etc)

c. Theintervalis the time between the end of the race and the start of the next race. It's currently set at 25
seconds, but for the first meet you might want to make it slower (:30).

d. Verify that the entry limits are correct: Small meet: 3 indiv, 1 relay; Big meet 2/1 Then click OK.

e. On the bottom right window, you’ll see I've factored in a 2 minute break every time the timers have to switch
ends of the pool. Modify that as needed.
f. Close the session window and the events window
4. If your pool isn’t 6 lanes, please make sure you do this next step! From the main window, click Setup—=>Options
a. The 4w option down, Change number of lanes for all Finals Rounds to: whatever your pool is. Click the
checkbox on the left before clicking OK. You'll get a check for confirmation; click Yes. Close the window.
5. You’re now ready to export your meet file to the guests coming to your meet and for your own Team Manager.
a. From the main screen, click File, Export, Events for TM

b. Double-check that all your information checks out as correct, then click yes.
c. On the next window, change the Conversions button to say “times CAN be converted to yards” and click OK.

d. Remember where you’re saving your file for your email.
6. Importing the entry files to your database
a. There are two ways to start the process: either click File=> Import—=>Meet Entries or use the import shortcut (an
arrow going down into a filebox )

b. Select the file & click OK, On the next screen, make sure the File meet name matches your meet title or you
have the wrong file



c. Make sure the Match on Entry Numbers is checked, Include entries with NT is checked, and all others are
unchecked. Note: If you're entering a team’s file for the second (or 3ra or 4t) time, it’s important that you
check the “Delete a team’s entries before importing” box. Click OK

d. The Import File Progress needs checked now. Hopefully it’'ll show one team, lots of athletes, entries, and even
some relays. If there aren’t relay names, make note so you can get them on the day of the meet. If there are
exceptions, you have problems!

7. Time to seed the meet; From the main screen, click on the Seeding Button

a. Before you go through this process, make sure the “Prompt if a Re-Seed” and the “Preview each Event” are

unchecked. Otherwise you’re going to get a ton of alerts

b. Click Select All at the top left and then click Start Seeding
8. Check for races to combine; From the main screen click on the Run screen
a. On the left column, check for events with 1 heat. If you have two adjacent events with one heat, click on the
events to see how many lanes are filled up.

b. If your two races have enough to fill the lanes, click and drag the names from the first race up to the top lanes.
Click and drag the names from the second race to the bottom lanes.

Don’t use any of the combine buttons on top, they’ll change event numbers and mess things up.

d. Make notes of what events you're trying to combine. You’ll want to draw a box around them on the heat sheet
upon printing. Close the run screen.
9. Prepare heat sheets; From the Main Screen Reports—=>Meet Program
a. All events that have entries will be listed as seeded; all unseeded events won’t print so don’t worry about what
you need to click/unclick

b. Inthe colums/format tab, use double or triple colums

c. Inthe Include in Meet Program tab, include Event Comments so your kickboard event shows properly; include
a line for results for parents, Heat Start Times if you want parents to have an idea of the meet timeline; If you
want to see where to put swimmers in empty lanes, you can select the Empty Lanes tab, but be prepared to
use more paper

d. If you're making a master copy you’ll take to get printed somewhere, mark the heats you’ve combined with a
large box and you’ll be all set.
10. Prepare timer sheets; Reports—=>Lane/Timer Sheets
a. Inthe effort to keep the paper printed down, but keeping information going to your computer, we’re going to
use “Continuous” under the format, we’ll uncheck “Double Space” and “Using Touch Pads”

b. You’re going to print these in groups by strokes: Group 1: Events 1-12 (select the first 12 events, whether or
not they have entries or not).

Create the report and print. Close the report

d. Then go to the top, de-select your events, select events 13-21. Repeat the printing process. The other groups
will be 22-29, 30-35, 36-43, and 44-51. That means each lane will get 6 sheets of paper.

e. If you have scratches at the meet, don’t worry about them. If you have people you need to add at the last
minute, you’ll need to hand-write their name on one of these sheets. Make sure papers are sorted by lane,
then by event number to make things easy.

11. Print entry lists for coaches (by far, the most helpful piece of paper for a coach besides the heat sheet); From the main
screen; Reports—>Entry Lists

a. |If printing for all teams, click “Separate team each page” button on the Report Type tab.

b. If printing for only one team, click the Team dropdown on the Filters tab at the top

c. If you want relay names, switch the report from Athletes Only to Relays Only. This will give the coaches a form
to print all relay names on and return back to you.

That concludes the pre-meet responsibilities



Running the Meet
From the main screen, click Run
1. Entering results

a.

Looking at the bottom, you should see Backup 1, Backup 2, and Backup 3 columns. If you don't, turn it on by
going to the top and clicking Preferences—>Run Screen—>Show Backup Times Column

When you get results, put the first time in Backup 1 and the second in Backup 2. If a swimmer doesn’t show up
for their race, put NS for “No Show” in the Finals Time column.

When the heat is finished, click the calculate button. It will average the two. If there’s a huge difference in the
two watch times, you may need to investigate to see which watch is right (send an assistant!). If everything
looks right, click Accept Adjusted. If you need to delete a time you know isn’t right, click Reject Adjusted,
delete the time, and calculate again.

When all heats in a race are finished, the blue “Seeded” at the top of the screen will turn to “Done”. Since we
aren’t scoring our meets, it won’t change into the pink “Scored”. If it doesn’t change to done, you’re either
missing a person’s results or a no show.

2. Printing Results

a.

There are two ways to do this; if you're doing it after every event, simply click the List button at the bottom
right of the screen. If you’re doing this in groups of events (Example: Printing all IMs together), click
Reports>Results

Select the events you want to print from; Single column or Double column is recommended.
i. If you do single column, you can print entry times so parents can see if their kids dropped or added
time. It's under the “Include in Results” tab, but only works for single column.

3. Other miscellaneous tasks

a.

Removing a swimmer that didn’t show up (If you have scratches, do them before you add new swimmers)
i. Click the Athletes button

ii. Find the athlete and click the ScratchAll button. It will remove them from their lane for each event
they’re signed up for.

iii. Close the athletes window.
iv. On the timer sheets, put a line through their name.

b. Adding an athlete that didn’t sign up

i. Click Athletes=>Add; Type in their names exactly as given to you by the coach (if you type Abby
and they’ve entered Abigail, they’ll have two different athletes), put in their DOB, make sure you
get their team correct, and add their gender. Their eligible events are now on the bottom left of
the screen. Click each event they want to enter their swimmer in.

ii. Close the Add Window, then the Athletes Window. You should be back at the Run screen.
iii. Go to the first event that the new swimmer wants to swim in, then click adjust.

iv. From the adjust screen, click the “Entered Only” button and look at the bottom until you see the
swimmer’s name. You can double-click their name to put them in the first available lane or click
and drag their name to any lane. Write down where you place them, click save. Don’t forget to
write on the timer sheet where you put them.

V. Repeat for the 2ndand 3raevents



Post Meet
1. Printing final results for coaches
a. Print these just how we did in 2B above. For entire sets, you may want to consider 2 or 3 column. Consider
saving a PDF of the results (top left corner near where you print) to go on the coaches flash drive.
2. Exporting results and making a backup
a. Results Export (for Team Manager)
i From the main screen, click File=> Export—>Meet Results or click the shortcut

ii. Don’t make any changes to the next screen

iii. Find a destination to save the file (flash drive or your computer)
b. Meet Backup (for Meet Manager)
i From the main screen, click File=>Backup

ii. Find a destination to save the file (flash drive or your computer)
iii. Make no changes on the backup options

Team Manager Tips

1. Importing meet events (the file you need to send to the meet host)
a. Click File>Import->Meet Events
b. If you haven’t received an events file for your 2na meet or beyond, then you can create a new meet:
i From the main screen, click Meets>Add

ii. Put in the information in and save the meet. Then click Events

iii. Click the Copy Events button, Select the 1st meet of the season, and click OK.
2. Importing meet results (after the meet)
a. Note: this file has to start with the name “Meet Results” or you have the wrong file

b. Click File=>Import—>Meet Results or click the filebox with the arrow down.
c. Find the file; it will unzip, the click it again.

d. If importing just your team, leave the “Add New Teams/Athletes” unchecked. If you want all teams, click it.
3. Making your meet entry process as painless as possible
a. After importing your meet events, click on Meets. You should see your meet in the list.

b. Highlight the meet by clicking once; Click Entries=>Swimmer Entry Status

c. This puts you on a list of your full roster. Go through the roster and mark who is coming and who isn’t. Click
the X to get back to the Meets screen.

d. Go to Entries>Entries by Event

e. Click the Only Pre-Entered Athletes—Now, when you try to determine relays, you can see how many relays
you’ll actually need based on how many kids you have attending. Do your relays from this screen.

f.  Yourindividual entries should be done from Entries—>Entries by Athlete
g. When you’ve finished all your entries, go back to the Meets screen. Click Reports—>Entry Report.

h. You'll want to do a pair of reports, both by meet event number and by name. On Event Filters, select individual
and relays, and unclick “Totals on Separate Page”. Have both reports for each coach.



